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Edit Designs Options 
 

The MDA editing possibilities are numerous and in fact quite amazing, even if you do not 
own digitizing software. If you do, then you may set your preferences to have the design 
open in your software, providing additional possibilities for editing and changing the design. 
An overview of this feature is mentioned in Lesson 1. 
 

For the purpose of demonstrating the many features of MDA Edit, the focus will be on the 
features contained within the program. You may refer to your personal software for 
additional features beyond this program. 
Begin by selecting the design within the catalog you wish to edit. (Note- Design Am. 15 from 
the Floriani Americana Signature Design Collection has been selected for this lesson.)  
 

 
 

Below is a review of the options available after right-clicking on a design in the Catalog 
Preview window: 

 Edit design- allows for many options that will be reviewed in the pages that follow. 

 Open- opens the design into your chosen software. 

 Open with… - enables you to open a default program from the Open option above. 

 Open in FTCU- your design will open in FTCU if you have the program installed. 

 Open in MDQ- your design will open in MDQ2 if you own the program. 

 Rename design- renaming the design may help you to identify your project. 

 Remove design from category- this removes the design from the category, but it will 
remain in the location on your computer. 

 Remove design from all categories- this will remove the design from any of the 
categories you have assigned. As with the option above the design still remains on 
your computer. 
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 Delete design- DO NOT use this option unless you wish to remove the design 
completely from your computer! 

 Send to compressed folder (zip) - this will make the design smaller and will reside in a 
zipped folder on your computer. Often used for emailing files or when saving to an 
external drive, requiring less space. 
 

The MDA Editing Workspace Opens 
 

 
 
(The Tools and Features of the Editing Program within the software will be reviewed below.) 
 
 

The Information Bar at the top gives the following information about your design: 
 

 
Name of 
Program 

File (Design 
Name) 

Machine Format Stitch Count # of Colors Width Height 
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The Standard Tool Bar includes: 
 

 

 File-Design saving, Printing, and Closing Options 

 Edit- Undo/Redo, Cut/Copy/Paste/Insert/Delete, Select All 

 View- Refresh, Zoom/Pan, Draw 3D/Grid/Stitch Points/Commands, Hoop/Select 
Hoop/Background 

 Tools- Split Wizard, Thread Chart Creator, Batch Converter 

 Tool Bars- File/View, Slow Draw, Color Palette/Sequence View, Status Line 

 Help- Support/License Activator, Manual, About (software version), Serial Number 
 

The Editing Tool Bar includes: 
 

 

Save/Print/ 
Slow Redraw 

Cut/Copy/ 
Paste 

Undo/ 
Redo 

Zoom  Preferences 
Design Split/ 

Color Sort  
Flip/ 

Rotation Tools 

 

The Left-Hand Tool Bar includes: 
 

 

Selection Tool- Left-click and then left-click on segments you wish to highlight. 

Magnifying Glass- Each time you click on this it zooms in for magnified viewing. 

Pan Tool- Allows you to move the grid with design to any location on workspace. 

Ruler Tool- Allows you to measure any segment of the design with prompts attached. 

3D- Toggle Drawing Of Stitches In 3D- Visual simulation of design when stitched. 

Grid- Show/Hide Grid- Toggles the grid on and off in the background of design. 

Hoop- Show/Hide Hoop- Toggles selected hoop on and off. 

Hoop Selection- Allows you to select a hoop specifically for your machine. 

Fit Hoop- Resizes the design to fit within your designated hoop, recalibrating stitches. 

Background Color- Select a Background Color or Fabric on which to view your design. 
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Color Tool Bar shows: 
 

 
(A)- Design Colors- shows colors included in actual stitching order 

(B)- Thread Chart Selection/Color Search/Current Color Color Options 

(C)- Design Info- Ready, uploading slide, Total Segments/# Selected/# Stitches/Hoop Size 

 

 

Set Up Workspace 

 

Software Properties- Refer to Setting Up Input Formats in Lesson 1.  This includes General 

Options, selecting a program for opening designs, Thread Brand Choice to Print, and Input Formats. 
 

 Right-click on the Ruler Bar. Place a check next to your preferred measuring system. The 
Ruler will change as well as the Measuring Tool. 
 

 

  

B
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 A 

C
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 A 

A
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 A 
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 Set Grid Options-  
 
(A)- You may Show Grid. (B)- Then click Grid Settings. (For this lesson we will work with 
the defaults.) (C)- You have options for Spacing both Horizontally and Vertically and line 
color. (D)- Grid Major Lines may be set for the number of lines between each major grid 
as well as line color. (E)-Style defines the type of line used on the grids and prevent. (F)- 
Snap to Grid locks a design within gridded line. The Gridlines may also be removed here, 
but it is easier to simply use the toggle feature on the left tool bar.            (G)- Finish setup 
by clicking OK. 
 

 

 

 Select Hoop Size- 

(A)- Click the Select Hoop Tool. (B)- From the dropdown arrow select your machine’s design 
format. (C)- From the dropdown arrow select the desired hoop for the design size. (D)- Click 
OK.  

(Note- Check MultiNeedle for that machine type. Hoop choices will then include additional 
sizes for those machines.) 
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Create Thread Chart Preferences 

 Thread Preferences- 

(A) View the many thread choices available in MDA. (Check Color match on loading  if you 
want MDA to display the selected thread.) (B)- Click OK for Color Match. (C)- Select the 
thread brand to use in MDA. (D)- Confirm 
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 Custom Thread Chart- 
 
(A)- If you have a variety of different threads you may create a custom chart by giving a 
name like, “My Thread Chart”. (B)- By selecting the brand thread and its number or color 
name you may then include it in your new thread chart folder. (C)-When this is chosen as 
your thread choice, the design will then show the closest match in the Design Preview. 
This takes time to create, but it will color match to those threads you have in your stash. 
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Lesson 
 

Let’s use some of the many right-click features in the Design Edit Program.  
 

1) Select your design 
from the catalog. 
Right-click on the 
image in Filter View. 
Then left-click on Edit 
Designs. 

 

2) The Edit Program will 
open. The Info Bar at 
the top includes: 

 Program Name 

 File Name 

 Machine Format 

 Stitch Count 

 Color Count 

 Size 
 

3) Slow Redraw-  
(A)- Select the Slow 
Redraw icon on the 
upper toolbar.  
(B)- Click the larger 
right arrow to start 
stitching simulation. 
(C)- The slide to the 
right regulates 
drawing speed. 
(D)- The small arrows 
move the stitch one 

 

A
B

C

D
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at a time forwards or 
backwards. 

4) Editing Design Colors- 

 

Change the color of 
the center of the left 
flower by clicking on 
it and clicking on 
color 4 in the color 
bar below. 

 

 

Rotating Designs 
1) Rotating Left  

 Click on the Selection Tool  . 
Click and drag a box around the 
design. 

 

 Click the Rotate Left, Rotating 
90°. 

 

 Click the Undo Back-Arrow, 
returning the design to the 
upright position 

 



10 
 

2) Flip Horizontally 

 With design selected, Flip 
Horizontally as shown 

 
 

3) Flip Vertically 

 

 While design is selected, click the 

Flip Vertically as shown.  

 Click Undo . 

 



11 
 

4) Rotate 45°  
 

 Type 45 in the rotation window.  

 Click Apply. 
 

 Click Undo . 
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Color Editing and Changing Sizes 

 

1) (A)- Enlarge the design 
by selecting All Items in 
the Sequence View. The 
Properties Box will open.  
(B)- Change the Height 

on the Transform Tab to 

9. When the Maintain 

aspect ratio is checked, 

notice how the width 

automatically changes.  

 

 
2) (A)- Make a hoop 

selection for 130 x 180 

mm. (A hoop that is too 

small was chosen 

purposely.)  

(B)- Click on Fit to Hoop. 

The design is now 

reduced and the stitches 

been recalculated.  

(A)- Click the Undo 

again.  

Hide the hoop by 

clicking again on the 

Hoop toggle.  
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3) Uncheck Maintain. 

Aspect Ratio.  

Click the red flowers and 

the yellow centers in the 

Sequence View. 

Change width to 4 in. 

Change Height to 5 in. 

Click Apply.  

 

(Notice how the flower 

size has changed.) 

Click Undo . 

 

4) Click Color Sort. This is 

used to combine 

identical colors when 

possible. Fewer thread 

changes are then 

needed. (This is nice 

when stitching multiples 

of the same design.) 
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Change Background Color 

 

1) Select the Background Color icon on the left toolbar. 

2) Color Selection window will open. 

3) Choose a color within a square. Use the slider bar on the right to view the shade. 

4) Click OK. The Background will now fill. 
 

 
 
 

Note- Using a Background Color is a great way to visualize how the thread colors will look 
when stitched on fabric. It gives you an opportunity to audition thread colors for stitching.) 
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5) Select Fabric.  

 

 

 

 Click Undo  to remove fabric background. Click Hide Hoop  . 
 

(Note- Undo  is a tool you will use often. It is often called your “best friend”. MDA has 
unlimited undo’s/redo’s which means you may return to the last function you saved.) 

 
  



16 
 

Split Wizard 

 

We originally set up the Preferences for a small hoop size. If you own a machine that has a 

4-inch Hoop, or you have a design that is larger in size than your maximum hoop, no 

problem! Split Wizard will spilt your design in the number of segments it will take take to 

hoop the entire design. The stitched Guidelines insure the proper overlap and perfect 

alignment of th eparts. When the design is complete the segments will not be visable. 

Let’s take a look at how this is done: 

(Note- Be sure your hoop size is 130mm x 180mm as done in the 

Color Editing and Changing Sizes section above.) 

 

(A)- Click on Tools and then click on Split Wizard. (B)- The Welcome Screen will open.   

(C)- Follow the prompts and click “Next”. Answer the questions. (Leave the default settings 

for the program.)  Click “Next”. (D)- Click Print. Click Finish. 
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The picture shows how the design is split into 2 Hoopings.  

The 1st Hooping will include the flowers.  

By clicking Print and Finish 5 sheets will print as shown below in the Printing Wizard. 

 
 

  

C    

 

 E

 A 
D

 

 E

 A 
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Printing From The Split Wizard 

 
 

(Note- The small red rectangle in the upper right corner on 
 4 of the pages correspond to the hoop position.) 
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Save Design in A Location on PC 
When the design is split there is a file for each section when saved. However, MDA 
displays it as a single file. Both sections will appear when transferred to machine for 
stitching. 

 

(A)- File > Save As. (B)- Save in a place on your computer that is related to this Lesson. 
You may wish to create a folder for MDA Projects. (C)- Name the file “4-Flower”.          
(D)- Select a file format for your machine from the drop down arrow. (Note- it is 
always best to save 2 files, one as a working file to use in FTCU or another software 
program- Floriani uses .waf. Save a second file for your machine.) (E)- Click Save. 
 

        

 
 

 
Notice the saved file will then appear in that location. 
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More Color Play in MDA Design Edit 

 

1) Click the Color Search Tool. 
2) Type a color name to locate. 

(pink, orange, etc.). This will be a 
color-match based on the Thread 
Preference selection. If you know 
the thread color that may also be 
entered in the color box. 

3) Click Find. 
4) The actual color appears to the 

right of the search tool. This 
opens related shades on the color 
bar. The first color is highlighted 
as the “match”, but you may wish 
to select a related shade. 

5) Click on the flower and it 
highlights. Then click a color in 
the Color Bar. The color changes 
and the color selection appear in 
the row above among the other 
thread colors in the design. 
 

How To Turn Off Sections- 
 

 Click on the eyeball to 
the left of all sections 
except the Red Flowers 
and Yellow Centers. 

 The “off segments” are 
not affected by changes 
made to the flowers. 
The vase is locked in the 
same position. 

 

(Notice how everything but the flowers disappears on the workspace? 
That makes it easier to select each of the flowers and change color.) 
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 Click on each flower and 
change color as described 
above.. 

 Ctrl + Click on each 
grayed eyeball so the 
thread names are 
selected. Right-click > 
Delete.  

 4 color flowers now 
remain. 

 

 Click and drag each flower to form a 
row. 

 Rotate the outside flowers so they form 
a border as shown 

 The dotted Guideline will help to align 
the flower centers evenly. 

(Note- Guidelines may be added in Design Edit by clicking and dragging a line out 
from  

 either ruler toward the center. Guidelines help to position items while editing.) 
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 Saving the New Design- 
 

(A)- File > Save As. (B)- Save in a place on your computer that is related to this Lesson. 
You may wish to create a folder for MDA Projects. (C)- Name the file 4-Flower Border. 
(D)- From the drop down arrow select a file format for your machine. (Note- it is 
always best to save 2 files, one as a working file to use in MDA or another software 
program- Floriani uses .waf. Save a second file for stitching in your machine.) (E)- Click 
Save. 

 

 

 

 

Notice the saved file will then appear in that location 
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How To Open In FTCU (or your software) From MDA 
 

(A)- Click the Catalog Preview Tab. This toggles you back to the Filter View. 
(B)-Go to Pending Folder. Name:  4-Flower Border.  Format:  waf. The design will 
appear in the Filter View.  
 

 

(C)-Add Keywords and drag to the desired folder. 
 

(D)-When this design file is accessed again in MDA, MDQ, or FTCU (or prefered 
digitizing software) it may be found in the Path indicted. 
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(E)- Right-click on the design. Click on Open in FTCU (or the software you designated in 
Setup Preferences). 
 

 
 

(F)- The Floriani splash screen appears as the software begins to load. 
 

 
 

When you are connected to the Internet, FTCU opens to the My Floriani Club Page. 
Floriani Software owners may join MyFloriani.Club, visit the Cloud for design templates 
you may access from anywhere, view exciting Blogs, find free projects and weekly 
How-To Videos, join live Webinars, and download hundreds of free designs, PLUS so 
much more! 

  



25 
 

(G)- This page connects 
you to the following with 
just one-click: 
 

 Software Support 

 FTCU Features 

 Visit the Forum 

 See Current Specials 

 Event Calendar 

 New Announcements 

 Ask Kayly Questions 
  

Close the Welcome Screen by clicking on the red X in the upper right corner. As you 
can see the design will be on the workspace just as it was as it was in Design Edit. 
 

 
 

 
The opening screen may be viewed in 3D by clicking on the 3D View button as shown 
above. This feature is available in Design Edit as well. 

 
Being able to toggle between the Catalog, Design Edit and Software without needing to 

close MDA is a great time saver! It makes opening, editing and saving so easy. 
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Printing Templates for Perfect Placement 

 
 
 

(A)- File > Print Preview. Click the Settings Tab and an options box will appear. Check the 

desired boxes. Title your design and it will appear at the top when you print. 

(B)- Click Print and two pages will print. One has a placement crosshair. The second has 

complete colored analysis, which includes: visual stitch segment, thread brand with 

color and number, as well as the required amount required for each segment. 

(C)- When Print On One Page in the Print Setting in Step (A) above, the thread information, 
without visual segments, appears at the bottom of the page. 

  

 File > Print Preview 
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Batch Conversion 

 

 
 
 

A)- Tools > Batch Converter 

(B)-  Batch Converter window 

opens 

(C)-  Source Folder is the 

folder where designs are 

located in the computer. 

Check the formats you want 

to find. 

(D)- Destination Folder where 

designs are saved. Check the 

formats you want to convert 

to.  

(E)-  Source Formats are 

those you want to include 

from your computer. 

(F)-Target Formats are those 

you want to convert to. 

(G)-Convert to complete the 
Batch Conversion. 

 

(Note- multiples of the same picture, with multiple formats, will appear in the Pending 
Folder. Therefore, checking only the boxes for the formats you use  

will make viewing and cataloging easier.) 
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Fancy That! 
 

The 4 Flowers began in MDA! You do not need to have digitizing software to accomplish this 

since MDA offers you the ability to Copy, Paste, Rotate and move selections. 

 
 

However, the ability to creatively edit a design in MDA and take it directly into digitizing 

software makes it possible to create these automatically. What possibilities! 

 

 


